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1.  Introduction
The Random Midi Arranger (RMA) is a basic midi sequencer with some unique options for 
randomly generating music with the click of a single button.  With the capability to generate 
random music, the RMA is designed to be an inspirational tool for the production of electronic 
music.  While the majority of randomized songs may not be usable, the RMA occasionally produces
bits and pieces that are suitable as starting points for future projects.  The RMA can export songs to 
a midi file, which can then be loaded into your favorite DAW for further processing and/or 
combination with audio tracks.  For simplicity, the sequencer is limited to only 5 tracks of midi 
data.  It does not support audio tracks or VST instruments, although it can send midi data to a VST 
host via a 'midi loopback' program.

The use of the sequencer itself is very straight forward, however, the randomization methods are 
unique and therefore may not be immediately intuitive.  In a nutshell, the sequencer can randomly 
select Clips from a preset file (preset.rma), and then apply 'Manipulators' to each Clip, which can 
modify the midi data according to specifically selected rules.  There are also manual randomization 
options which allow the user to specify the overall song structure, specify track instrument type 
(bass, lead, drum, etc.), select specific midi Clips for each track/part (via drag-n-drop or from a list 
of presets), and select specific Manipulators (also via drag-n-drop or from a list of presets) which 
will be used by the randomization engine when generating a song or track.  Entire songs can be 
generated quickly with a single click of the 'Auto Randomize Song' button.

The RMA randomization engine features a scoring system, which allows the user to score 
individual Clips and Manipulators so that they are used either more frequently or less frequently 
based on their score.  Essentially, the RMA gradually learns which methods will produce the best 
musical results for a specific user.  Additionally, the preset file can be modified using Clips and 
Manipulators provided by the user.  See the 'Editing the Preset File' chapter for more information.

This user manual will demonstrate how the randomization  features can be used to generate a single 
Clip (a pattern consisting of 64 steps), an instrument track, or an entire song.

2.  System Requirements
Window XP, Vista, 7, 8, 10, or newer.
A minimum screen resolution of 1000x700.
A midi instrument (software or hardware)

3.  Installation
The Random Music Arranger does not need an installer.  Simply extract the RMA.zip folder into 
any location on your computer.  Connect your midi hardware devices or software 'loopbacks' and 
then left-click on the rma.exe file to launch the program.  On Win 10, a 'Smart Screen' warning may
be displayed.  Select 'More Info' and 'Run Anyway' to launch the program.

The program also ships with a 'preset.rma' file which contains Clips and Manipulators used during 
randomization.  You will be asked to locate this file if you use the randomization features.  This 
preset file is actually just a RMA song file, so you are free to add or delete Clips or Manipulators or 
even create your own preset files from scratch.  See Chapter 8 for more information about preset 
files.
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4.  Midi Device Configuration
Assigning Midi Instruments
Before launching the program, be sure to connect the midi devices that you intend to use.  If you 
add or remove devices while the program is open, you will need to click each track's 'Midi Out' 
arrows to reset the device selections.  Device selections are saved within the .RMA song format, 
and the program will attempt to open the original devices when a song is loaded.
By default, all versions of Microsoft Windows include a basic midi music synthesizer, which is 
probably the first instrument that the RMA will attempt to use for each track when the program is 
first opened.  If you intend to use a hardware instrument or 'loopback' to control a software 
instrument, you will need to select that instrument using the 'Midi Out' arrow keys at the left edge of
each track.

If you intend to use a software instrument that is running on the same computer, you will need to 
install a 'midi loopback' to route the midi data from the RMA program to your software instrument.
Use a web browser to search for a midi loopback that will work with your specific version of 
Windows.  The free 'loopMIDI' program is an excellent loopback if you are using Windows 10.

IMPORTANT NOTE ON CPU RESOURCES:  Triggering software instruments running on the 
same computer as the RMA will require a great deal of processing power.  If you experience audio 
dropouts or timing glitches, try to reduce the number of software instruments in use.  In general, 
sample based instruments will use significantly less CPU than those instruments that generate audio
via synthesis and effects processing.

Default Track / Instrument Types
The first four RMA tracks are generally intended for synthesizer type instruments and are set to 
midi channels 1-4 by default.  Track #5 is generally intended for drum type instruments and is set to
midi channel 10 by default.  

The preset Clips in the preset file used during randomization are arranged into 5 different 
instrument types:
Track 1 is used for BASS synthesizer type sounds (short duration, and generally in C2 octave range)
Track 2 is used for LEAD synthesizer sounds  (medium duration, C3 octave range)
Track 3 is used for STRINGS, HORNS, and sustaining PADS (long duration, sometimes in chords)
Track 4 is used for ARPEGGIO sounds (short duration, multiple octaves)
Track 5 is used for DRUMS on midi channel 10 (General Midi standard with full 128 note range)

In addition to being able to select a midi device and channel for each track, the 'Manual 
Randomization' page allows you to change the default instrument type for each track.  For example, 
track #3 could be changed to a 2nd bass synth and track #4 could be changed to a 2nd Drum track.  In 
this example, track #3 would actually draw bass Clips from track #2 in the preset file.  Likewise, the
new drum track #4 would use drum Clips from track 5 in the preset file.  See the 'Manual 
Randomization' and 'Editing the Preset File' sections for more details.  Obviously you will want to 
select a midi instrument that corresponds to the selected track type.  For example, selecting a piano 
type instrument on a 'Drum' track is probably going to sound terrible.

If desired, you can save your preferred midi device/channel configuration and desired track types 
into a blank RMA song file.  Then simply drag-n-drop this song into the RMA interface to erase all 
data and restore your preferred configuration.
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5.  Quick Start
After clicking on the rma.exe file to launch the program, select your desired midi device and 
channel for each track using the arrows on the left side of the sequencer display.  By default, the last
track should be set to trigger a drum instrument.  Click on the 'Auto Randomize Song' button at the 
top left of the display and locate the 'preset.rma' file when prompted.  This will generate a new 
random song, and may take several seconds, depending on your processor speed.  When finished, 
hit the 'Play' arrow button at the bottom of the screen.  Hitting the 'Stop' button twice will rewind to 
the beginning of the song.  The sequencer grid can also be dragged left and right to move through 
the song.  Songs may then be saved in a '.rma' file format or exported to midi via the 'File' menu.

TIP:  Clicking on the Gradywerks logo will instantly randomize only the currently selected Clip by 
selecting a random preset Clip and applying a random preset Manipulator to it.  You can even do 
this while the clip is looping, without stopping playback.

Click the 'Manually Randomize Song' button to open a new page which allows the user to change 
the song structure and specify which Clips and Manipulators are used for each part of each track.  
At the bottom of the page are controls to determine the song structure.  A song may consist of a 
maximum of 6 parts of variable length.  Clip and Manipulator files can be dragged into the specific 
'stacks' for each part A-F of each track, which can then be randomly selected into the sequencer 
using the 'Randomize Track' button.
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6.  The Main Display
General
The File menu on the main page has a 'Save Song' option to save a RMA song file (.rma file 
extension).  Additionally, songs can be exported to a midi file using the 'Export to Midi' option on 
the 'File' menu, for further editing within a DAW program.  To load a song file (.rma), drag the file 
from a folder into the main display or use the 'Load Song' option on the File menu.

The main display of the RMA is divided into 2 parts.  The sequencer area at the top shows the Clips 
in each track, as well as the midi device assigned to each track.  The bottom section is used to edit 
the note data within the currently selected Clip.  The 'Auto Randomize Song' button at the top left of
the screen can be used to generate a song using Clips and Manipulators from a preset file.  The 
'Manually Randomize Song' button opens the 'Manual Randomization Options' page.

The very bottom of the screen contains the buttons to control the playback.  Pressing the play button
will initiate song playback. Pressing the stop button once will stop playback and reset the position 
to the first step of the current bar.  A second click of the stop button will rewind the position to the 
very first bar.  Arrow buttons can be used to change the song position in 1 Clip increments (64 
steps).  Additionally, the song position can be changed by left-clicking in the Clip sequencer area 
(upper part of the display) and dragging the sequencer left or right with the left mouse button 
down.  On touch screen displays, simply swipe the sequencer right or left to fast-forward or rewind. 
The bottom of the screen also contains controls for changing the song tempo and for looping a 
region of Clips.  Note that the loop length can be lowered to .25 or .50, which will loop either the 
first 16 or 32 steps of a Clip, respectively.

The Sequencer:
The sequencer at the top of the screen is used to arrange the Clips in each track.  Selecting a Clip 
via left-click will show the Clip's note data in the Note Editor on the bottom of the screen.  Right-
clicking on a Clip will bring up a pop-up menu with options including cut, copy, paste, 
import/export, rename Clip, and change Clip color.  There is also an option to change a Clip's score 
on this menu, as well as an option to adjust Continuous Controllers.  The same pop-up menu also 
has an option to randomize a single Clip using preset Clips and Manipulators that can be selected 
randomly or manually from a list.  

TIP:  Clicking on the Gradywerks logo will instantly randomize only the currently selected Clip by 
selecting a random preset Clip and applying a random preset Manipulator to it.  You can even do 
this while the clip is looping, without stopping playback.

To import a single Clip (.pno) into the sequencer, drag the file to the desired location.  Likewise, to 
import a midi file (.mid), drag the file into a Clip on the sequencer.  Only the first 64 steps of the 
first midi track will be imported into the Clip.  There is currently not a provision to import entire 
midi songs or tracks.  Imported Midi Clips will used the 'Default Imported Midi Clip Color' 
specified on the Edit menu.

The sequencer also accepts drag-n-dropped '.rbs' files from the legendary Propellerhead Rebirth 
program.  Multiple '.rbs' song files can be imported simultaneously for rapid pattern importing.  
Only the note data of each pattern will be imported.  All other song data and automation will be 
ignored.  Empty patterns and patterns with every note 'on' will be ignored.  The desired destination 
track for each Rebirth instrument can be specified from the option on the main 'Edit' menu.  
Imported patterns are always imported into the first available empty clips of the destination track.
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The Note Editor:
The Clip editing grid at the bottom of the screen shows the actual note data within the currently 
select Clip.  Each Clip consists of 64 steps (total of 16 quarter notes) across the horizontal axis and 
pitch (midi note numbers 1-128) across the vertical axis.  The piano keyboard on the left can be 
scrolled to show higher and lower octaves by dragging it vertically.  Additionally, a mouse wheel or 
touch swipe can be used to scroll the display vertically.

Normally the Note Editor display will show all 64 steps within the selected Clip.  The zoom 
function on the 'View' menu can be used to zoom in on either steps 1-32 or steps 33-64.  This is 
especially useful when editing notes with a touch screen display.

To create a note, left-click on any position in the Note Editor grid.  Left-click and drag the tail of the
note horizontally to change note duration.  Left-click and drag the tail vertically to change the note 
velocity.  To delete a note, left-click the note again.  To move a note, left-click on the note and drag 
it to the desired position.  Right-clicking on a note brings up an option menu that allows you to copy
and paste steps, transpose notes, and rename notes.  Note renaming may be useful for drums tracks. 
For example, note #36 could be renamed 'Bass Drum'.  This name will be displayed when the 
mouse cursor is moved over a note.
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The Continuous Controller Editor:
Each Clip can contain data for up to two Continuous Controllers.  Right-click on a Clip and select 
'Continuous Controllers' to open the controller editor.  With Continuous Controllers, you can change
midi parameters such as volume, pan, filter cut-off, etc.  Select the desired controller number on the 
left edge of the display.  Note that there is no 'smoothing' of controller values between pattern steps.

The following image shows the Continuous Controller editor:

The controller values in this image were created by editing this Clip using the MPG64-A, which has
a 'Controller Automation' feature for making ramp, sawtooth, and random automations.  In this 
example, the top controller destination is set to midi CC#1 and the bottom controller is set to CC#2. 
Although each track only allows for 2 controllers, the actual CC destinations can vary from Clip to 
Clip within each track.
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Editing Clips Using the MPG64 Programs:
Right-click on a sequencer Clip to bring up a menu option to edit a Clip using the newest versions 
of the Gradywerks MPG64-A or MPG64-R programs.  The RMA program will prompt you to locate
the MPG64 program.  There currently is not tempo synchronization between the RMA and MPG64 
programs, so the RMA program will be temporarily suspended while the MPG64 programs are 
open.  The contents of the current Clip will be transferred to the MPG64 program.  To return back to
the RMA, click the MPG64's Record button to close the MPG64 and transfer the edited pattern back
to the RMA.  Clicking the 'X' button to close the MPG64 will return to the RMA without modifying
the original Clip data.  Important:  Some midi data may be lost when editing a Clip with the 
MPG64 programs.  For example, the MPG64-A is a monophonic sequencer which can only trigger 
one note per step.  Additional notes above the lowest note number on each step will be erased.  
Similarly, the MPG64-R drum patterns can only contain a maximum of 20 different note numbers 
(with constant velocities and durations per row), so some selective data loss may occur.
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7.  The 'Manual Randomization Options' Page
Overview:

Clicking on the 'Manually Randomize Song' button near the top left corner of the main page will 
open the 'Manual Randomization Options' page.  This page allows you to manually set the overall 
song structure, select the intended instrument types for each track, and specify which Clips and 
Manipulators will be used during randomization.  Note that the 'Auto' randomization feature on the 
main page will erase ALL Clips and Manipulators selected on the Randomization Options page, and
will replace them with randomly selected Clips and Manipulators.  Likewise, it will randomize any 
song structure settings on this page (the Edit menu on the main page contains an option to 
randomize without modifying the song structure).  The actual instrument types for each track will 
NOT be randomized, and can only be changed by the user.

Song Structure:
At the bottom of the 'Randomization Options' page are controls for defining the overall song 
structure.  Note that this structure is global in nature, meaning that it will be the same for all tracks 
in the song.  The song structure for each track consists of a maximum of 6 parts (A-F).  The length 
of each part can be manually set using the up/down arrows in each part.  Also, note that some parts 
may be repeated, while others may not be used at all, depending on the settings.  For example, a 
structure of A2-B2-A4-B4-C2-D2 will play 2 Clips from part A, followed by 2 Clips from part B, 
then 4 more Clips from part A, 4 more Clips from part B, 2 Clips from part C, and finally 2 Clips 
from part D.  The total song length will be 16 Clips.  Any Clips in part E in this example will never 
be used.
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The Clip and Manipulator 'Stacks':
Specific Clips and Manipulators to be used for each part are placed in the columns or 'Stacks'.  
When randomizing a song part, the randomization engine will only use Clips and Manipulators that 
are contained in the corresponding Stack.  If a song part is not selected in the global song structure, 
or has a length of zero, any Clips in that Stack will be ignored.  When a stack does not contain any 
Clips, that part of that track will always be silent.  If a stack contains multiple Clips, the Clips are 
selected randomly, with some priority given to Clips with a higher 'Score'.  Note that some Clips 
may be selected multiple times while others may not be used at all.  To place a Clip into a stack, 
drag-n-drop a Clip file (.pno extension) or midi Clip (.mid extension) into the desired stack.  
Alternatively, right-clicking on a stack brings up an option to import Clips from the preset file by 
selecting them from a list or using a 'random' button.  The 'random' option will always select Clips 
that match the instrument type of the current track, although you can manually select Clips intended
for different instrument types.  For example, the randomization engine will never put preset drum 
Clips into a bass synthesizer track, but you can select them manually from the lists of preset Clips.

In an effort to prevent overly dense midi data (ie. All 5 tracks playing simultaneously), the 
randomization engine may opt to leave some parts of certain tracks blank if numerous other tracks 
in the same part also contain data, regardless of whether the current stack contains Clips.  In 
general, drum tracks are considered as a higher priority than having additional synth tracks.

Special Clip Attributes:
There are currently 4 special attributes that can be assigned to Preset Clips to force a certain 
behavior during song rendering.  They are defined as follows:

1. 'Start' Clips:  These Clips will only be used as the first Clip in a song part.  These are 
generally used to introduce a new song part by fading in notes.

2. 'End' Clips:  These Clips will only be placed at the end of a song part.  Similar to 'Start' 
Clips, they are used as a transition between song parts.

3. 'Previous' Clips:  These Clips will attempt to steal Clip data from Clips in the previous part 
(replacing the actual data in this Clip). Therefore, this song part for this track will sound 
similar to the previous part.  If the previous part does not contain any Clips, the Clips will 
use any data in the actual 'Previous' Clip.

4. 'Above' Clips:  These Clips will attempt to steal data from the previous track.  These can be 
useful for creating layered sounds, where multiple instruments will play the same notes. 
Note that drum tracks will only steal data from other drum tracks.  Similarly, non-drum type 
instruments will not use data from drum tracks.  Track 1 cannot steal data from any 'Above' 
tracks during rendering, as the remaining tracks have not been rendered with data yet.  In the
event that the previous track does not contain Clips in that part, the Clip will use any data 
that was contained within the actual 'Above' Clip itself.

Right-click a Clip in the sequencer to change the Clip attributes when creating or editing a preset 
file.

Midi Manipulators:
The right side column in each part is used for 'Manipulators'.  A Manipulator is a set of rules that 
can modify the existing midi data in a Clip.  Like Clips, Manipulators can also be placed into the 
Stacks via file drag-n-drop.  Manipulators can also be selected from a list of presets by right 
clicking on a Stack, which opens a pop-up menu.  The pop-up menu also contains an option to 
create new Manipulators.  A dialog will open where the user can select up to ten different rules for 
the Manipulator.  When a rule is selected, a description of the rule will be shown at the bottom of 
the display.  Some rules, like those that increase note pitch one octave, for instance, are specific for 
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synthesizer type instruments, while others are designed specifically for drum Clips.  Normally, 
when using Auto randomization, the program will avoid Manipulators that do not match the current 
track's instrument type.  The Manipulators have a radio button which allow the user to force a 
Manipulator to be applied to specific types of tracks regardless of the types of rules contained 
within it.  If a Stack does not contain any Manipulators, the Clips in that Stack will be used as-is, 
with no modification.  If a Stack contains more than one Manipulator, the Manipulator to be applied
to a given Clip will be selected randomly, with some priority given to Manipulators with a higher 
'Score'.  There are even some rare occasions where the randomization engine will apply multiple 
Manipulators to a single Clip.  Like Clips, Manipulators can be forced to apply only to the first or 
last Clip in a song part by assigning a special attribute via right-click menu options.  This would be 
useful, for example, for a Manipulator that fades midi volume in or out.

The image below shows the 'Midi Manipulator' editor window, which is opened by right-clicking on
a Manipulator on the 'Manual Randomization Options' page and selecting 'Edit Manipulator'.  Each 
Manipulator can actually contain up to 10 rules which modify the Clip data.  A description of the 
selected rule appears at the bottom of the display.  Some of the rules may have additional 
parameters which can be set by the user.  'Random' buttons can also be used to randomly select rules
and parameters for the Manipulator.  Note that some rules have a random element, so each time a 
track is rendered, the Manipulator may do something entirely different, even when applied to the 
exact same Clips.
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Manual Randomization Page Example:
The Manual Randomization Page is something unique to this program, and may not be immediately
intuitive.  To illustrate how the Manual Randomization Page works, lets look at an example:

The previous image shows the Manual Randomization Page for Track #2, which is set to a 'Lead' 
track type.  Therefore, an 'Auto' randomization will only pull 'Lead' type Clips and Manipulators 
from the preset file.  The Auto Randomize Song button on the main page will always replace any 
Clips or Manipulators on this page with randomly selected ones (for every track), but it will never 
change the track's instrument type.  It will also randomize the global song structure if the option is 
selected on the Render Engine Preferences page.  Looking at the global song structure section at the
bottom of the image, this song will consist of 2 Clips from Part A, 4 Clips from Part B, followed by 
4 more Clips from Part A, 4 more from Part B, 4 from Part E, and finally 2 from Part F.  Note that 
Parts C and D are not selected in the song structure in this example.  Therefore, any Clips or 
Manipulators contained in the Stacks for Part C and D will not be used when generating this track.  
Also note that there are not any Clips in the Stack for Part E.  The song section for Part E will be 
silent for this individual track.

Since the Stack for Part A only contains a single Clip with no Manipulators, that Clip will be used, 
as-is, for the first two Clips in the song (as well as Clips 7-10).  The Stack for Part B contains two 
Clips and two Manipulators.  When that Part of the track is randomized, the program will randomly 
select from the two Clips and will randomly apply one of the two Manipulators to that Clip.  Note 
that in this case, the Clips and Manipulators used for Part B will be randomly selected for EACH 
Clip in that Part.  Hence, the Clips in Part B may alternate between the two Clips in the Stack, or 
they could consist of just one or the other.  Also note that when Clips and Manipulators are 

13



randomly selected, there is some consideration given to their scores.  Higher scoring Clips and 
Manipulators will be used more frequently.  If you create a Clip or Manipulator, you can manually 
set this score, if desired.  See the scoring system section for more details.  The next two parts of the 
track in this example will again use Clips and/or Manipulators from Stacks A and B (4 Clips each).  
After that, 4 Clips from Part E would be selected, although the Stack in Part E is empty, so these 4 
Clips will be silent.  Finally, two Clips will be selected from the Stack for Part F, which contains 
two Clips and a single Manipulator.  For these last two Clips, each one will be selected randomly 
from the Clips in the Part F Stack, and the single Manipulator will be applied to both Clips.

Perhaps the best way to learn how to use the Manual Randomization Page would be to start with a 
blank song, and add Clips and Manipulators to a single Stack/Part.  Then use the 'Randomize Track' 
button and view the results in the main sequencer.  It may be helpful to select clips from different 
instrument types, which are different colors in the default preset file.  This will help to visualize 
where those clips end up in the main sequencer.  Note that each time a track is manually generated, 
it may sound differently, even if no changes are made to the Stacks.  This is because the Clips and 
Manipulators are selected randomly from the stacks each time a track is generated.  Additionally, 
some Manipulators have random elements that function differently each time they are applied.
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Special Clip Attributes Example:

Refer to the above image during this discussion of the behavior of Clips and Manipulators with 
special attributes.  The image shows a simple song generated from a variety of Clips with different 
attributes.  The first 2 Clips in the sequencer are from stack A on the Manual Randomization Page.  
The gray Clip was saved into the preset file as a 'Start' clip.  Therefore, when randomizing a stack 
containing multiple clips, the Start Clip will ONLY be used as the first Clip in that part.  Part A has 
a length of 2, so the first Clip in the resulting track is the Start Clip and the second Clip is the white 
'Normal' Clip.  Part B just contains 1 'Normal' Clip and is set to a length of 1, so it was placed in the
third position in the track.  Part C contains a purple 'Previous' Clip.  Since the previous stack 
contains a clip, the 'Previous' Clip is ignored and the previous white clip from Part B is used 
instead.  If the previous part was empty, the note data within the 'Previous' Clip would have been 
used as-is, and the fourth Clip in the sequencer would have been purple.  Part D contains an 'Above'
Clip, which actually stole a light blue clip that was placed in the track above this one.  In this case, 
both tracks will be playing the same notes during Part D.  Part E is the final part of the song and has
a length of 2.  Similar to 'Start' Clips, if a stack contains multiple Clips, the 'End' Clip will ONLY be
used as the last Clip.  Therefore, the last Clip in the song used note data from the 'End' Clip.
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This example also has two Manipulators in the stack for part E.  In this case, the 'Start' Manipulator 
will be applied to the white Clip, and the 'End' Manipulator will be applied to the green Clip.

The behavior of these Special Attribute Clips and Manipulators can be difficult to follow, but the 
important thing is that they assist in making randomly generated songs sound a little bit less 
random.  They can add repetition between parts and also make the transition from one part to the 
next less abrupt.  The preset file contains a few of these types of Clips and Manipulators, and you 
are free to create new ones if desired.  Chapter 9 will discuss how to edit the preset file.
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8.  The Render Engine Preferences Page
The Render Engine Preferences page can be found on the Main Page's 'Edit' menu.  This page has 
some options that control the behavior of the 'Auto Randomize Song' button.  The settings on this 
page are also saved within a song file.  It may be desirable to create and save a blank 'template' song
which, when loaded, will configure all midi devices and channels as well as the settings on this 
page.  
Each track has the following controls:

• Silent Part Probability - This slider determines how likely it is that an individual part within 
a track will not contain any note data.  Moving the slider towards 'Max' will result in tracks 
that are mostly silent.  Drum tracks should generally use a lower setting so that the drums 
will play throughout the song.

• Part Repetitions – This slider determines how likely a song part is going to be repeated for 
that specific instrument track.  Songs can consist of up to 6 different song parts.  Moving the
slider towards 'Max' will result in tracks that use the same Clips and Manipulators in 
multiple song parts, so the parts will sound similar.

• Clip Variations Per Part - This slider determines how likely a song part (Clip Stack) is going 
to contain multiple Clips.  Using a high value will result in song parts that contain multiple 
Clips for a more random sound.  Using a low value will generally only allow a single Clip 
which will be repeated for the duration of the song part.

• Manipulator Variations Per Part - Similar to 'Clip Variations Per Part', this slider determines 
how likely a song part is going to contain multiple Manipulators.  More Manipulators in a 
song part will generally result in a more random sound, as each Clip can have a random 
Manipulator applied to it (and within each Manipulator can be multiple rules, some or all of 
which can be randomly selected!).  Using a lower value will result in greater consistency 
and repetition within each song part.

• Instrument Type Drop-Down Box – This selector is a duplicate of the 'Track Type' buttons 
located on the 'Manual Randomization Options' page.  It determines which type of clips in 
the preset file will be used for each track.  See the 'Editing the Preset File' Chapter for more 
info.

• Available Midi Channels – This powerful feature is enabled by clicking the 'Enable 
Randomly Selected Midi Channels' box at the bottom of the page.  Once enabled, more than 
one midi channel can be selected for each instrument track.  Each time a song is 
randomized, one (and only one) of the selected midi channels is randomly chosen.  The 
actual midi channel selected for the track will be shown in the Midi Channel display for 
each track on the main page.  In the example image below, Channels 10, 11, and 12 are 
enabled for the drum track.  Each channel could be connected to a different drum machine or
kit, which would be randomly selected each time a random song is generated.  If using midi 
loopbacks to control software synths, it is recommended to create a separate loopback for 
each track, so that all 16 midi channels are available for each track.  In this case, a 
randomized song can select from a maximum of 80 different midi instruments (5 tracks * 16
instruments each = 80).
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• Randomize Song Structure - Checking this box will generate a random song structure each 
time a new song is generated.  If the box is not checked, the existing song structure (length 
of each part) will be used, although each part will still be filled with random Clips.  In this 
case, the randomized song will always be the same length.  The song structure can be 
manually adjusted at the bottom of the 'Manual Randomization Options' page.

• Randomize Tempo – Check this box to randomly change the tempo each time a new song is 
randomly generated.  If left unchecked, the existing tempo displayed on the main page will 
be used.

• Enable Randomly Selected Midi Channels – This box enables the ability to randomly select 
a midi channel from the available channels for each track every time a new song is 
generated.  Unique results can be obtained by making several different sounding instruments
available for each track (keeping them on separate midi channels).

• Randomize These Sliders – Selecting this option will randomly adjust all sliders on this page
each time a new song is generated.  Otherwise all existing slider values will be maintained.

The following image shows the 'Render Engine Preferences' page:
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9.  Editing the Preset File
The 'preset.rma' file can be opened and saved like a regular RMA song file.  It can even be given a 
different name.  There are some significant differences from a regular song file though.  In the 
preset file, the tracks are arranged as follows:

Track 1 stores Clips intended for BASS synthesizer instruments.  
Track 2 stores Clips intended for LEAD synthesizer instruments.  
Track 3 stores Clips with sustaining notes for STRING, HORN, or PAD type instruments.  
Track 4 stores Clips with ARPEGGIO type patterns containing notes with short durations.
Track 5 should always contain drum patterns.  These Clips should conform to the general midi 
standard for drum note numbers.  For example, midi note #36 is intended for bass drum sounds and 
note #38 is intended for snare drum sounds

The order of the Clips in each preset track is not important, since the preset file is not intended to be
played like a song.  Clips in the preset file are selected randomly based on their track type, with 
emphasis given to Clips with higher 'Score' values.  See 'The Scoring System' chapter for details on 
how to change the score of Clips or Manipulators in this file.

Preset Manipulators are stored in the 'Stacks' section of the preset file.  Manipulators may be stored 
in any Part of any Track, but will be available for ALL tracks when randomizing a song, regardless 
of which stack or track they are placed in.  Manipulators can be created that are Synth or Drum 
specific, but their placement in the preset file is not important.  As with Clips, Manipulators can be 
given a Score to determine how frequently they are used.  The Clip side of each Stack is currently 
not used in the preset file.

The preset.rma file currently contains Clips that would be suitable for electronic dance, techno, or 
industrial music.  These presets could be replaced with Clips containing other musical styles if 
desired, or entirely new preset files could be created.  All preset files should have a minimum of one
Clip in each track (which are actually instrument types).  Additionally, there should be at least one 
'Synth' type Manipulator and at least one 'Drum' type Manipulator in the one of the stacks.  If no 
Manipulators are found in the preset file, the randomization engine will just use the Clips as-is, 
without any modifications.

Don't forget that Propellerhead Rebirth '.rbs' pattern data can be imported into the program by 
dragging multiple '.rbs' files into the sequencer.  This can be very useful for quickly building large 
preset files.

If you do modify the preset file while the RMA program is open, use the 'Reload Preset File' option 
on the File menu of the main page to load the preset into memory.  This option can also be used to 
select a different preset file to be used by the randomization engine.  
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10.  The Scoring System
All Clips and Manipulators in the preset file contain a score which determines how frequently they 
will be used during randomization.  To adjust the score of a Clip in the sequencer, right-click on the 
Clip and select 'Clip Score' from the pop-up menu.  Move the slider to the desired score and click 
'OK' to change the score.  If the EXACT Clip can be found in the preset file, the score for the Clip 
in the preset file will be changed as well.  If the sequencer Clip has been modified by either a 
Manipulator or by manual note editing, no changes will be made to the original Clip in the preset 
file.

TIP:  To view the score of a Clip in the sequencer, hover the mouse over the desired Clip.  The score
will be displayed as the third number shown in the Status window.  The first two numbers represent 
the Clip's track and location in the song, respectively.

To change the score of a Manipulator, right-click on the Manipulator on the 'Manual Randomization
Options' page.  Select 'Manipulator Score' from the pop-up menu and adjust the slider.
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11.  Have Fun
Much of the fun of using the RMA results from experimenting with different midi instruments for 
each track.  What may sound terrible with one set of instruments may sound great with another.

Here are some other things to try:

• Explore the vast amount of Rebirth '.rbs' files available on the internet.  Drag-n-drop 
multiple files to bulk import pattern data into the sequencer.  Hundreds or even thousands of 
Rebirth patterns can be imported in a matter of seconds!

• Assign multiple instruments (each on a different midi channel) to each track, which can then
be randomly selected each time a new song is generated.  See the 'Render Engine' chapter 
for details on how to do this.

• Assign drum sounds to ALL 128 note numbers on the drum track.  The Manipulators are 
designed to occasionally produce notes outside of the normal General Midi range.

• Use 2 drum tracks in a song to create layered drums.

• Create layered synths by copying Clips from one track into another or by assigning two 
instruments to the same track.

• Try different tempo settings.  The Render Engine has an option to randomize this.

• Randomize individual Clips while they are looping.  Click on the 'Gradywerks' logo to 
quickly randomize the selected Clip.

• Randomize your instruments too!  Many software synths and VST hosts have a button to 
create random patches.

• Add life to tracks by assigning continuous controller modulations to your midi instruments. 
The MPG64-A program can be used to edit Clips to add random modulations and sweeps.

• Create a new preset file from scratch.  Import midi Clips via drag-n-drop into the sequencer. 
Be sure to add some Manipulators to the 'stacks' of your preset file.

• Midi Clips can be derived from a variety of sources including midi hardware and software.  
Many of the presets were derived from randomized MPG64 Clips or by applying 
Manipulators to existing Clips.  Use the MPG64-A to generate quick arpeggios.  There are 
also programs available to convert C64 SID tunes and Rebirth songs to midi, which can then
be imported via drag-n-drop.
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If you do create additional Clips, Manipulators, or Songs, please share them via the Gradywerks 
Drop-Box.  I hope to include user generated Clips and Manipulators in future preset files.  Give 
your Clips a unique name and RGB color so that they can be identified as your own.  Additionally, I
hope to create some new rules for the Manipulators in future versions of the program.  If you have 
any suggestions, please let me know.  Visit the Gradywerks Facebook page to share your thoughts 
and promote your creations.

Have fun,
Greg O'Grady
www.gradywerks.com
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